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1.	 导言
感谢您购买 NTi Audio 的 Acoustilyzer AL1 产品，它非常适合专业音频的测
试应用。Acoustilyzer 提供前沿的声学功能，包含一个语音清晰度 STI-PA 
量测模组的选件，另外也有基本的电气量测功能。我们相信您会高兴的使
用它!

本手册详细描述 Acoustilyzer AL1 的量测功能与操作。关于声学与电气量测
的更多应用信息可参考 NTi Audio网站 “www.nt-instruments.com”。

Acoustilyzer AL1 可以是单机独立的测试仪器或对于已有的用户使用升级套
件切换至Acoustilyzer AL1。此升级套件也可将 Minilyzer 的功能安装到AL1
（STI-PA 的功能是选件）。

产品及套件包含下面项目:

Acoustilyzer AL1 1x	Acoustilyzer AL1
1x	MiniLINK CD (计算机软件)
1x	MiniLINK USB 缆线
1x	Acoustilyzer 测试 CD 
1x	Acoustilyzer 用户手册

ML1-AL1 转换套件 1x	MiniLINK CD (计算机软件)
1x	Acoustilyzer Test CD (音频样本)
1x 转换套件认证码
1x	Acoustilyzer 用户手册
1x	Minilyzer 用户手册

STI-PA 量测选项 1x	STI-PA 测试 CD (STI-PA 测试信号)
1x STI-PA 认证码
1x	Acoustilyzer 用户手册
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CE 认证声明

我们，生产厂家	

					     NTi Audio 公司
					     Im alten Riet 102
					     9494 Schaan
					     列支敦斯登, 欧洲

在此声明 Acoustilyzer AL1 产品( 2004年发行),符合下列标准或其它规范的
文件。

EMC-Directives:			   89/336, 92/31, 93/68
Harmonized Standards:	 EN 61326-1

此声明随产品有任何改变而失效,NTi Audio 不再书面认定。 

日期:						      2004 年 9 月 1 日

签名:			 

职务:	 技术总监
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国际保证与维修

国际保证
NTi Audio 保证对于 Acoustilyzer AL1 在购买后一年内因材料或生产过程的
不良负责，并同意在这期间免费维修或更换无法修复的不良元件。

限制
此保证不包含因意外，错误使用，疏忽，连接或安装任何不是本产品提供
的元件所造成的损坏，部分元件缺失，连接设备到电源适配器，输入信号
电压或连接器类型非规格内，电池极性连接错误。特别是不保证特别的，
伴随发生的损坏。
若服务及维修不是由 NTi Audio 授权的服务中心，或者仪器已被打开则保修
失效。

维修
如有故障，将你的 NTi Audio Acoustilyzer 装在原包装箱中，附上1 张能证
明购机时间的发票复印件，运输损坏不包含在本保证中。寄到你所在国家
中确认的 NTi Audio 服务中心,中国区为恩缇艾音频设备技术(苏州)有限公
司。进一步连络信息请访问 NTi Audio 网站: www.nti-audio.com
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敬告

为了避免在操作仪器中发生任何问题，请遵守以下规则:

•	 有目的有计划的使用仪器。

•	 不能将仪器连接高电压输出装置，例如电源功放，电源适配器等等。

•	 不能拆解仪器。

•	 不能在潮湿环境下使用仪器。

•	 电池电量不足或长时间不使用仪器要移除电池。

测试与校正证书

这是保证 Acoustilyzer AL1 已通过完整的制造商规格测试。NTi Audio 建议
购买后一年校正仪器。之后每一年校正调整一次。
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2.	 概述
Acoustilyzer AL1 是用于分析声学信号
的一个精巧工具。可简单快速分析声学
环境与备有重要的电气量测功能。对于
实际声学信号精确的显示在大液晶显示
屏上。

AL1是精度级别1的仪器，可与量测麦克
风 MiniSPL (级别 2)与 M2010 (频率响
应级别1)连接使用。也可使用其它相容
的麦克风。

级别 1 声学分析仪
NTi Audio 提供级别1频率响应的麦克风 
M2010 (需外接幻象电源)。与 M2010 量
测麦克风结合，成为高精度级别1的声
学分析仪。 

级别 2 声学分析仪
Acoustilyzer与MiniSPL连接使用，成为
一个级别2的声学分析仪。 MiniSPL为电
池供电的量测麦克风，是 Acoustilyzer 
理想的附件。
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Acoustilyzer 功能

Acoustilyzer AL1 拥有许多量测功能,可经由
下拉式菜单操作。

光标为基本操作元件(左图反选区),各种功能
可经由光标选取来操控。

• SPL/RTA:	 宽频带的声压级与时间平均声压级(LEQ)量测，全倍频
程或 1/3 倍频程值

• RT60:	 混响时间量测，1/1 倍频程带宽分辨率

• FFT:	 实时 zoom FFT

• POLARITY:	 量测扬声器与线信号的极性

• DELAY:	 扬声器与扬声器间的延迟时间量测

• RMS/THD:	 电平与失真量测

• STI-PA:	 语言清晰度量测 (只能在收到激活 STI-PA 认证码后才能
看到)

• CALIBRTE:	 校正所连接量测麦克风

容易操作

光标所选取的地方可更改
设置

所有可选取的设定都可由下面操作来调整:
 
•	 选择需要设定的项目后按”回车”键。

•	 如果有多个项目可选择，选择区块会闪
烁。可使用上下方向键选择后再按回车
确认。
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连接口

在AL1主机上方,有三个连接口和一内部麦克风:

•	 XLR 与 RCA 输入端可以将信号传送给AL1。

•	 一个 3.5 mm (1/8“) 监听输出接口可以连耳机。这样，使用者可听到
任何电气输入信号。

•	 内置麦克风可用来测试扬声器极性与延迟时间测量。此麦克风不支持
声压级(SPL)的量测。

XLR 与 RCA 
输入端

监听输
出端

内部的麦克风

注意:	 不可同时连接 XLR 与 RCA 输入端!
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电池更换

打开后方背盖，安装 3 颗 1.5 V type AA, LR6, AM3 碱性电池到AL1电池槽
内，如下图所示。典型的一组电池寿命为16小时。

         

注意:
•	 我们不建议使用可充电的镍镉(NiCd)或镍氢(NiMH)电池。
•	 请勿插入不同型号的电池。
•	 请同时更换所有电池，不能将新旧电池混合使用。
•	 注意插入电池的极性是否正确。
•	 尽快取出更换快没电的电池，同时更换所有电池。
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3.	 基本操作
虽然可以量测的功能与选项设定范围很广，但是 Acoustilyzer 的操作是很简
单容易就可以明白的。

菜单列

测试结果

电源开/关-背光
退出按钮

回车 / 光标控
制键

显示器屏幕分为上方的菜单列与下方的量测结果显示。

光标控制键和退出按钮可以浏览所有信息与功能。

•	 目前的设定(量测功能,滤波器)

•	 量测结果(数值或图形显示)



12 13

起始屏幕

在按下开启键启动仪器时按住不放，能保持
显示起始画面。起始画面中会显示仪器序
号，序号前三个英文字(例如ANK675A2A2)
。

注册成功后，AL1的起始画面会显示客户的
信息。详细内容请参考手册后面”客户化起
启屏幕”章节。

菜单列

菜单列可以选择基本的测试配置。

   量测功能 选择测试结果
显示方式

记忆体菜单与电
池状态

输入滤波器  屏幕设置

        



14 15

量测功能

•	 SPL/RTA:	SPL 与 RTA 量测
•	 RT60: 		  混响时间 
•	 FFT:			   实时的 zoom FFT
•	 Polarity:		  扬声器极性 
•	 Delay:		 延迟时间 
•	 RMS/THD:	 电平有效值与失真
•	 STI-PA:		  语言清晰度 
•	 Calibrte:		  校正菜单

选择测试结果显示方式

Acoustilyzer 的 SPL / RTA ,RT60 与 STI-PA 
功能的测试结果有两种不同的显示方式。

例如:SPL/RTA“123”的选项显示声压的数
值，而图形的选项显示实时的频谱分析(如
左图)。

快速切换
按住ESC键不放，再按左/右方向键可快速
切换同一个量测功能的两种显示方式。
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输入端滤波器

依照所选的量测功能不同，有下列的滤波器可使用:

SPL/RTA 功能:

滤波器 应用

FLAT 平坦
平坦的频率响应(无滤波)

全频带声压级,包含未经计权的所有声频
信号成分的特殊应用;

A-计权	
A-计权滤波器依据 
IEC 61672 标准

一般声级测量被要求针对人耳听感进行计
权时适用。

C-计权
C-计权滤波器依据 
IEC 61672 标准

特别高声级的声级测量被要求针对人耳听
感进行计权时适用。确认滤波器设置与测
试规范要求是否一致。

X-CRV-1 

反 X-曲线滤波器依据 ISO 
2969 标准。

电影院安装应用。

RLB (=Revised Low 
frequency B-curve)
依据 AES 文件”音乐与言
语的响度评定”的广播响度
滤波器

应用于广播器材的响度测量。更新的B-计
权Leq测量与人耳经验主观经验有最好的
一致性。
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RMS/THD 功能:

滤波器 应用

FLAT
平坦的频率响应(无滤波器)

预设的测试设定。

A-计权	
A-计权滤波器

在声音广播应用上依据 IEC61672 标准测
量待测体残余噪声。

C-计权
C-计权滤波器依据 
IEC 61672 标准

特殊应用。

HP400
高通 400 Hz ，依据 DIN 
45045 标准, -120dB/dec.

将任何电源频率成分从测试信号中移除。

HP19k
高通 19 kHz

将测量信号中任何低频成分移除，以测量
关键的公共广播系统中任何 20kHz 导引
音电平。
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屏幕设置

依照下面步骤，在这个页面中可以设定
Acoustilyzer AL1 基本设置:

•	 移动光标到欲更改的设置项目后按回车
键。

•	 使用光标控制键选择到更改后的状态。
•	 按下回车键确认。

自动关闭电源 可以设定AL1在多久没按键后自动关闭电源。可选的设定有 3 
分钟, 10 分钟, 30 分钟, 60 分钟或不启用自动关机。如果选择了不启用
自动关机，用户必须手动关闭电源，否则仪器会一直为开启状态直到电
池用完。

	 在 Acoustilyzer 与 MiniLINK 计算机软件连接的状态操作时 
在 AL1 与 MiniLINK 计算机软件连接下操作时，是由计算机供电且
省电功能关闭:-自动关闭电源-自动关闭背光。当关闭 MiniLINK 软件
后，Acoustilyzer 仍由计算机供电，但省电功能将启用。

自动关闭背光 可以设定在没按键后，背光持续亮多长时间。可选的设定有 
3 秒钟, 10 秒钟., 60 秒钟或不启用自动关闭背光。如果选择了不启用自
动关闭背光，背光将开启直到仪器关闭。背光开启时间越长越耗电。

LCD 显示器对比度 这里可调整对比度。也可以在任何量测页面下按住 ESC 
键不放，然后按上/下方向键快速调整对比度。

多重设定 可以保存四组独立的设置，要启用多重设定可按下回车切换。启
用后，下次开启 Acoustilyzer 时起启画面会显示四个设置号供用户选择 
(1, 2, 3 或 4)，选择后按回车确认，在关机时，所有参数的设定会自动保
存在当前的设置号中，方便下次使用。
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记忆体菜单与电池状态

所有的量测结果可以保存在仪器内部的记忆
体中。每笔记录的档名由测试功能与连续数
字000 - 999编排，例如:“A001_RMS_THD” 
或“A002_RT60”。数字超过999会重新以
000开始。
你可以以下列的保存方式保存测试结果:

•	 STORE+BMP
保存测试结果的数值，包含截图，以位
图 BMP (=bitmap) 格式存储于记忆体
中。

•	 STORE
仅保存测试结果的数值，占用较少的记
忆体空间。

•	 VIEW + DELETE
保存的量测结果以升序方式排列，最新
的记录在最上面，剩馀的记忆体空间会
显示在屏幕右上角。
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所有标示 BMP 的截图可从仪器上直接预览:

•	 使用光标选择档案清单中的记录。

•	 按下回车键不放。

•	 记录会显示在仪器屏幕上。

•	 在记忆体菜单选中记录预览后。你可以
在任何时后按下ESC键不放，再按回车
键可快速预览之前观看的记录。 

删除单笔记录
每笔记录可单独从记忆体中删除。

•	 选择欲删除记绿旁的 DEL 后按回车键。

•	 在弹出的视窗中选择 OK 后按回车键确
认。

•	 记录从仪器的记忆体中删除。

删除所有记录
选择 “DEL ALL“ 可删除记忆体中所有记
录。
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载入
Acoustilyzer 的一些功能支持将测试结果从
内部记忆体中载入。这对于察看先前的量测
非常有用。

下列的量测支持这项功能:
•	 SPL/RTA
•	 RT60
•	 FFT
•	 STI-PA

注意:	 在载入与察看记忆体中的测试结果
时，任何正在量测的过程不会中
断。

使用 SPL/RTA 的应用范例:
•	 在记忆体菜单选择 LOAD 后按回车。
•	 保存的数据会显示列出来。

•	 选择想要看的测试记录。
•	 按回车确认，记录前的方框会填满(如右

图)。 
•	 按退出键(光标会跳到OK)，按回车确

认。
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载入的记录会显示在屏幕上。屏幕右上方
LOD 的会呈闪烁状态。

可察看每个频段的声压，目前状态下不可用
的功能不能选择。

要回到量测模式按右上方记忆体菜单的 
LIVE MODE 。

电池电量不足指示
在电池电量不足时，屏幕右上角 “MEM” 
会显示电池电量不足的图示，需尽快更换一
组电池。
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4. 	 量测功能

总览

功能 测试结果
显示 测试功能选项

SPL/RTA 声级计
声压级,最大/最小声压级,噪声等效声级,C-计权
峰值声压级
实时频谱分析仪
1/1 与 1/3 倍频程实时频谱分析仪
显示每个频带的声压级,最大/最小声压级,噪声等
效声级

RT60 混响时间
全倍频程频带的分辨率，基于 T20 结果
混响时间
在短时间内列出详细的测试结果，包含相关因子

FFT 实时的 Zoom FFT

POLARITY 极性测试
声学扬声器或电气线路信号 

DELAY 延迟时间
量测电气参考信号与声学信号输入间的传送延
迟时间

RMS/THD 电气量测
电平有效值, 总谐波失真+噪声, 频率

STI-PA 语言清晰度
公共广播系统语言清晰度的 STI 或 CIS 测试结
果(只有收到 STI-PA 激活认证码后才能看到此项
目)

语言清晰度
测试各频带的 LEQ 与 STI-PA 调制指数

CALIBRTE 校正菜单
用于外部量测麦克风，灵敏度预设的是 NTi 
Audio MiniSPL
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SPL/RTA - 声级计

Acoustilyzer 有全面且完善的声级计功能，含有计时功能可做单一或重复量
测。所有量测结果会记录在内部的记忆体，作为后续的研究分析。 

量测结果显示在屏幕中央，可选择下面两种测试功能选项分别显示在大和
小的结果显示区
 
	 •	 SPL 	 实时声压级
	 •	 MIN SPL 	 量测到的最小声压级

•	 MAX SPL 	 量测到的最大声压级
	 •	 LEQ  	 噪声等效声级
	 •	 PreLEQ  	 之前一段时间的 LEQ  (仅计时器在重复模式可用) 	

•	 LcPEAK: 	 C-计权峰值声压级

内置的计时器允许自动地:
•	 经过用户定义的一段时间后停止 LEQ, LcPEAK 与 最大/最小声压级

量测。
•	 经过用户定义的一段时间后重新开始新的 LEQ, LcPEAK 与 最大/最小

声压级量测。

时间计权指示器/
选择器

计时器状态 暂停 量测的时间重置 测试周期

声压级条状指针与范围
指示器

输入范围指标

大测试结果

小测试
结果
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测试应用:“计时器状态”设置

计时器关闭
(适用于标准量测)所有数值都连续的记录与
监看。量测的计时器显示测试已经过多长时
间。按重置图标可将计时器与测试结果归
零。

单一计时器
使用用户定义的时间量测声压级: 
•	 设定需要的测试周期。
•	 当定义的时间开始倒数量测完成后，时

间会在”00.00.00”闪烁。 
•	 测试结果 LEQ, LcPEAK 与 最大/最小 

SPL 会停止量测。
•	 改变测试周期时间或按重置重新量测。

重复计时器
在用户定义的时间不断自动重复量测。 
•	 设定需要的测试周期。 
•	 当定义的时间倒数至零，测试结果会重

置且自动开始一个新的量测。
•	 之前量测的 LEQ 会显示为 PreLEQ (这对 

LEQ 的监控非常实用)。
•	 改变测试周期时间或按重置重新量测。



24 25

暂停:  LEQ, LcPEAK 与 MAX/MIN 的量测可以暂停
	 •	 选择 PAUSE 图标后按回车键。

•	 PAUSE 图标会闪烁。
•	 目前的 SPL 值会持续量测和显示。
•	 选择 PAUSE 图标后按回车键可再开始量测，计时器也开始作用。

重置: 按下图标可重新开始新的量测，计时器与测试结果也会重启。

测试周期时间: 只适用于单一与重复计时器状态。
•	 单一: 预设为10分钟。 
•	 重复: 预设为10秒钟。

量测计时器: 量测时间(小时:分钟:秒)。

大和小的结果显示: 之前列出的量测功能选项中，可设定两种量测，分别于
大和小结果显示中。

时间计权 :所有声压级量测 (声压级与最大 /最小声压级 )为时间计权量
测。声压级高度的改变为平坦会使显示的值有较快或较慢的改变。 
可用的时间计权, 依据 IEC 61672 标准,有

•	 SLOW  (长上升(attack) 与释放(release)的响应时间  t = 1s)
•	 FAST  (短上升(attack)与释放(release)的响应时间t = 125ms)

全频带时间计权的值 ( ) 与实时频谱分析  ( ) 相同。

过载

若 输 入 电 压 超 过 所 设 定 的 输 入 范
围，OVL (Overload)会闪烁。只要 OVL
闪烁状态， LEQ 与 LcPEAK 的结果就不
精确。 
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输入选择范围器与条状指针
	

在 SPL/RTA 量测模式下，AL1 有三种量测范围。每个范围要参照所使用
的麦克风灵敏度。MiniSPL 在 20mV/Pa 的灵敏度下有以下量测范围:

 
		  20 到 100 dB		  40 到 120 dB		  60 到 140 dB

 
选择的输入范围会显示在屏幕下方的条状指针，可以使用范围指标来改
变范围。条状指针显示目前模拟信号的声压级。 

主要的范围指标 
	 为了达到最好的量测精确度，要选择适合的范围，叫做“pr imar y  

indicator range”。正确的设定可避免信号过强与影响实际噪声的量测结
果。 

	 屏幕左下方两个范围指标可帮助用户设定最佳的范围。一旦条状指针找
到更低的主要范围指标，RNGE下方的指标会开始移动，表示现在声压
级量测不精确。条状指针范围需要手动修改，选中往左移动的指标然后
按回车键。

注意: 量测中改变范围会重置所有正在进行的量测。

超过主要范围指标，三个信号过强的图
标会取代大显示结果的读值(如左图)。
 
•	 选中 RNGE 下方向右的指标, 然后按

回车，改变条状指针为更高范围。 
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SPL/RTA - 实时频谱分析仪

Acoustilyzer 声级计功能使用级别 0 滤波器，各别1/3rd倍频程或全倍频程频
带测试结果。显示每频带的声压级，最大/最小声压级与噪声等效声级。

使用可用的数学函数可平均存诸的频谱。最大-最小显示对听觉范围特性的
描述很有帮助。

输入范围指针

声音频谱

设置菜
单

暂停 重置 光标读值

X-轴 手动选择范围 Y-轴

声音频谱的显示不用中断任何正在进行的声压级量测，因此改变  到  
的显示方式不会中断正在进行的声压级量测。 

输入滤波器
SPL/RTA 可单独选择对于频带的值 ( ) 与实时频谱分析 ( ) 输入的滤波
器 - 所以例如，当频带的值使用A计权滤波器，实时频谱分析可使用 FLAT 
滤波器。请注意激活不同的滤波器。 

注意:	 改变滤波器设定会重启正在进行的量测。
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设定菜单

SET 菜单可以设置下列的量测设定与显示选
项:

RES - 分辨率
按回车可选择 1/3rd 倍频程或全 (1/1) 倍频程
频带分辨率。

SHOW - 测试结果
可显示每频段的目前声压级，最大/最小声
压级与噪声等效声级。

目前的声压级显示是填满黑色的长条图(如
左图)。
 

噪声等效声级频谱显示是未填色的长条图(
如右图)。

最大/最小声压级范围显示是填满黑色的长
条图。光标读值可以显示所选频带的最大、
最大与最小差、最小声压级。 

选中读值区按回车，按仪器上的上下方向键
可以切换显示以下的值:

	 - 最大声压级
	 - 最小声压级
	 - 最大-最小的差
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TWTD - 时间计权
适用于目前声压级量测，可用的响应时间，
依据 IEC 61672 标准，有

•	 SLOW (长上升(attack)与释放(release)时
间)

•	 FAST (短上升(attack)与释放(release)时
间)

全频带时间计权的值 ( ) 与实时频谱分析  
( ) 相同。

HOLD - 光标锁定
光标显示全频带上最高的声压级。光标的显
示可维持1 - 9秒锁定(自由选定)。这样可用
于找到反馈频率。

光标读出: 在指示的频段实际的电平测试结果，光标读出显示箭头指向的频
段的中心频率与电平，光标自动跳到频谱中最高电平位置。

 
也可以由手动光标读出:
•	 选择读出数据栏位，并按回车键。
•	 数据读出部分周围的框架闪动。
•	 将光标移动到相对的测试结果。

暂停/重置/输入量程指示/ TWTD-时间计权:
	 这些控制与声级计屏幕完全一致，也具同样的效果。RTA 与声级计测量(

例如,在 RTA 屏幕按 PAUSE 同样的暂停了宽带 LEQ, LcPEAK, 以及MAX/
MIN SPL测量)。

. 
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X-轴:  20 Hz - 20kHz

Y-轴: 尺度(灵敏度)可手动调整。
•	 选择 Y-轴上显示的值后按回车键。
•	 使用上/下方向键沿着Y轴滚动显示电平，以及左/右键缩放Y轴刻度, 

例如,变更显示分辨率。
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SPL/RTA - 记忆功能

在SPL/RTA模式下包含的记忆功能有:

SPL/RTA - 声级计
•	 LOGGING: 以表格形式记录所量测参数到内置记忆体中。

SPL/RTA - 实时频谱分析仪
•	 LOAD: 载入保存的测试结果到 AL1 显示屏上。
•	 MATH: 选择存储于记忆体中的测量数据完成数学平均计算。

记录
Acoustilyzer 能随着时间记录各种电平，例如监测长达数小时的声压电平并
记录在分析仪的内置记忆体内。每当记录周期届满时测试结果即被存储并
以 “_dt” 标记。记录的进行在预设的测量周期完毕后自动停止。记录的结
果能被下载至计算机，并可以通过软件如Excel 软件进一步观察。 

注意:		  存储的结果会保持在AL1记忆体，即使在记录过程中电池电力不
足。

记录时会记录下列参数:

LEQ			   在全部量测期间的Leq值，测量周期由量测定时计所指示与控
制。

PreLEQ		  在前次量测期间的Leq值 (只在重复计时模式有效)。

LEQ_dt		  实际记录期间Δt内的短时间LEQ。可以组合 LEQ_dt 值而得到
任何期间的LEQ 值:
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MIN_dt		  实际记录期间Δt内的最低SPL。时间计权值(SLOW/FAST)。

MAX_dt		  实际记录期间Δt内的最高SPL。时间计权值(SLOW/FAST)。

一个 SPL/LEQ 的记录以 Microsoft Excel 查看的例子
(没有 LcPEAK)

LcPeak		  实际量测期间内的最高C计权SPL峰值。时间计权值(SLOW/
FAST)。测量周期由量测定时计所指示与控制。

LcPeak_dt	 实际记录期间Δt内的最高C计权SPL峰值。时间计权值(SLOW/
FAST)。

SPL_Act		  指示记录期间内实际量测的 SPL 电平。请注意 LEQ_dt，MIN_
dt 与 MAX_dt 能比SPL_Act 更精确地描述期间内的特性。
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一个 SPL/LEQ 的记录以 Microsoft Excel 查看的例子
(只有 LcPEAK)

OVER_dt		 一个 “1” 代表在记录期间Δt的一个过载。

OVER_Hold	 一个 “1” 代表在测量期间的一个过载。

UNDER_dt	 一个 “1” 代表在测量期间的一个不过载  

		

准备记录
从记忆体菜单上选择 LOGGING。会弹出记
录设定的屏幕:
 
记录时间的设定
声压级最长记录时间记录根据剩余记忆容量
与测试周期而定。记录器在用户定义的时间
内可能记录最多约 580 点。使用者可以以
hh:mm:ss格式设定测试周期(Δt)与总记录时
间。

注意:	 在SPL/RTA 记录期间仪器可以切换到
显示音频频谱。这样做是可行的并不
会中断记录的进行。

察看记录的数据
量测的数据会保存到档案 “Axxx_LOGSPL”,  
xxx 是序列数字。使用 MINILINK 计算机软
件可以察看详细的数据。
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LOAD - 载入测试结果

详细信息请参考之前的章节“记忆体菜单”。
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MATH - 记录的数学平均

MATH 实现将存储的测试结果平均的功能。

应用范例:
•	 显示先前可用来平均的记录数据。
•	 用回车键做出选择 → 在选择的前方的方

框会填满。

•	 选择要平均的任何数量的测试结果。
•	 按 ESC 钮并以回车确认。

测试结果的平均饥饿果显示在 AL1 屏幕缩
写的 MAT 在状态条记忆栏闪动。

能读出个别的双频带值，Y-轴可改变甚至
LEQ 或显示 MIN/MAX 测试结果。

•	 在记忆菜单下选择LIVE 回到实时模式。
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混响时间 RT60

Acoustilyzer 支持全倍频程分辨率混响时间的量测，依据 ISO3382 标准，
自动触发，自动量程与平均功能。

什麽是混响时间 RT60
混响时间 RT60 是指声源停止发声后，声压级降低 60dB 所需的时间。实际
上由于衰减量程及环境噪声的干扰，造成很难在 60dB 内都有良好的衰减曲
线，因此 RT60 一般是基于 T20 量测。这样只需要每个倍频程 35 dB 的衰
减。  RT60 测试结果是基于衰减 20 dB 推算出的。 

测试信号
建议使用一个闸控粉噪声做测试信号。各种开/关时间不同的测试音轨包含
在的 AL1 测试 CD 中。或者 Minirator  仪器中也有粉噪声信号。

a. 长条图显示

倍频程 

开始 暂停 量测状态

独立倍频程频谱 RT60 上标指示RT60 下标指示

X-轴,
等级-10 
dB声压级
标示

测试结果
数量自动
平均

量程, 环境噪声
初始的记录

倍频程卷轴
63Hz - 8kHz
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b. 如何量测

由扬声器发出一粉噪声到待测房间。声源从发出到声能量被吸收达平衡，
停止声源信号。AL1会感应到声源中断，触发自动量测并计算衰减时间，得
到RT60 测试结果。 

请依照下面量测 RT60 的步骤:

量程 
•	 选择 RANGE 后按回车，量测目前房间

内的声压级(无测试信号状态)。 

•	 SET RANGE 视窗弹出。选OK确认自动
量程。

现在的上标是完成一个量测所需要的最小粉
噪声。下标无任何测试信号时的环境噪声。
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•	 依照待测房间以适当的开/关时间，开始
发出粉噪声信号，建议开关时间略大于
环境的混响时间为佳。

注意:	 开始先使用低的声压级(保护您的耳
朵，避免听觉伤害)。

•	 增加测试信号的声压直到每个频段的标
记超过了所需最小测试信号声压(如左图)
。可使用均衡器 EQ 向上调整各频段声
压。

开始 RT60 量测
•	 选择 START 后按回车开始量测混响时

间。

•	 START右边状态显示变成 ARMED。
•	 完成几个测试周期，会计算出一个测试

结果的平均。
 

•	 每个倍频程频段的声压级增加超过上
标。

•	 之后每个倍频程频段声压级下降至下标
以下，计算RT60。 

•	 关闭测试信号。

成功量测混响时间的频段会显示成功的标
记。
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显示测试结果
详细的 RT60 测试结果x.xx秒列出在 RT60
测试结果屏幕上。用下列方式选择详细的测
试结果显示: 
•	 使用屏幕上的菜单

•	 或同时按下 ESC 与左/右方向键。

注意:	 在的量测过程中，记忆体菜单无法使
用。

c. RT60 测试结果显示

测试结果(以
秒表示)

相关因子，以 % 表示或是量
测的不确定因素

相对的测试结果，
以条状图表示

测试结果
选择

得到测试结果的
数量

删除选择的测试
结果

开始 暂停

倍频程卷轴
63Hz - 8kHz

测试结果选择: RT60 的量测功能可做连续的混响时间测量。自动对所有量
测计算出平均测试结果。 



40 41

在每个测试结果上按仪器的左/右键，可以看到:

最后测试结果
选择 LAST ，显示最后测试周期的测试
结果。
 
您可使用仪器上/下键以显示 63 Hz 或8 
kHz 倍频频段的测试结果。

单一测试周期结果
CYC xx，显示各别的单一测试结果，xx
是连续的数字。

平均的测试结果
AVRG，显示所有量测的平均测试结果。
相关因子会以不确定因子取代 ，以 %表
示。 

相对测量结果，显示如条状图: 为了简单的读出数据以条状图显示混响时
间，藉着倍频程频带和最长的测量混响时间显示条状图最长的长度。其
它的倍频程频带测量结果显示以相对于最长的时间有条状图表示。

相关指数百分
比 %

相关指数百分比 %
(适用于单一测量结果)
当信号源断掉之后完美的线性声压级衰减此
指数会是 100%。线性的偏差结果是较低的
相关指数。(在可靠的 RT60 测量结果典型
值为 80 - 100%）。
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不确定指数百分
比 %

不确定指数百分比 %
(应用于平均测量结果)
基于至少三个个别的测量结果,计算出不确
定指数百分比。这个指数等于统计基于任意
创建的粉噪声测量信号分析测量结果精度 (
在可靠的RT60 测量结果，典型值为 0 - 15% 
)。请参阅标准 ISO 3382。

错误指标

删除单一测试
结果

不成功的 RT60 量测会显示由于某些错误造
成，可以单独删除。无效的结果会排除在计
算平均时。

•	 LOW LEVL
这表示在量测中测试信号声压太低。 

→ 增加测试信号声压，检查所有声压要
超过上标。

→ 使用用于 RT60 的测试信号，较长的
开关时间，这样可达到下标

•	 CORR<70%
表示相关因子小于70%，这样量测结果
不可靠。

•	 T>18S
量测到的混响时间超过时间限制18秒, 可
能因为对环境噪声不正确的量程造成。

重新量程，再开始量测。
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FFT 分析

Acoustilyzer 包含非常快速的实时 Zoom FFT 功能，全频率范围分辨率达 
0.73Hz 。同时显示 93 个频点。 

FFT量测是观察梳状滤波与窄频影响的理想工具。它可以对音频系统的频率
响应做详细的研究。

FFT 音频
频谱

设置菜
单

暂停 光标读值

显示的起始频率 Y-轴显示的结束频率显示的频率范围

设置菜单

设置菜单可以设定下列量测与显示选项:
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Range - AL1 输入范围
Acoustilyzer 有不同的输入范围。 
•	 进入FFT模式会自动设定范围。

•	 输入范围是否有任何削波或高噪声发
生。

SHOW - 测试结果
选择显示目前的声压级或平均声压级(LEQ)
。执行范围设定或再选择 SHOW: LEQ。

HOLD - 光标锁定
光标显示全频带上最高的声压级。光标的显
示可维持1 - 9秒锁定(自由选定)。

暂停:  FFT 量测过程中，用户可以暂停。
•	 选择 PAUSE 图标后按回车。
•	 PAUSE 图标开始闪烁。
•	 选择 PAUSE 图标后按回车继续量测。

光标读出: 显示频率的实际电平值，光标读出显示频率与相对应的电平值，
光标自动跳到频谱中最高电平位置，控制也可以由手动光标读出:
•	 选择读出数据栏位，并按回车键。
•	 数据读出部分周围的框架闪动。
•	 将光标移动到相对的测试结果。
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X-轴: 线性刻度, 由92频点左至右显示起始频率, 频率范围及终止频率带有缩
放功能。

Y-轴: 尺度可以手动调整。
•	 选择Y-轴上显示的值后按回车。
•	 使用上/下键滚动显示Y轴电平以及用左/右键缩放Y轴刻度, 例如变更

显示分辨率。

如何量测:

•	 选择 FFT 功能。光标自动显示出最大声
压。

•	 选择光标读值区按回车确认(如左图)。区
块会开始闪烁。 

•	 使用左/右方向键查看其它值。

缩放光标位置
•	 选择光标读出栏位。
•	 使用下方的箭头键将分辨率放大到0.7 

Hz 用上方的箭头键缩小分辨率。
•	 按左右键移动光标。

缩放与快速 X-轴 移位
•	 选择 x-轴频率范围栏。
•	 对显示中心频率的缩放功能。
•	 使用左右箭头快速移动 x-轴。
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应用: FFT 与白噪声

白噪声常被用来当作量测声学系统的测试信号。FFT对这信号显示平坦的频
谱。将白噪声送到电声系统并以麦克风进行 FFT 测量可以显示很高频率分
辨率的系统频率响应。 

请注意频率响应最常包含的是两方面:
a)	 电子与扬声器的真实的频率响应。
b)	 干扰效应（产生梳状滤波器）。

高分辨率FFT干扰效应 能容易的被看到，这些是在1/3 倍频程分辨率的RTA
上几乎是不可能的。

AL1 的缩放 FFT 可以放大任何频点的分辨率最高达 0.73 Hz。 

4 x 缩放 →
电平降低6 dB

白噪声与缩放功能
白噪声的能量是平均的分布在整个线性频
率轴。我们假设有一个白噪声信号以频宽
20kHz 测量电平为 0 dB。 

如果我们降低频宽至10kHz会有什么现象
呢? 

→ 我们只测量到一半的能量–结果电平值为-3 
dB (10*log10(0.5))。

这是实际上我们使用 FFT 放大时会发生的
现象. 每次我们放大 “Zoom In”，频宽就是
一半 – 造成每一个频点低了 3 dB 电平。
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极性测试

极性测试的功能可以用 Minirator MR1 的极性测试信号来检查电缆与扬声器
的极性。Acoustilyzer 提供下列的配置:

a. 扬声器极性测试

•	 从 Minirator 提供扬声器系统极性测试信
号。

•	 调整声压(在信号发生器MR2、MR-PRO
或功放上) ，让测试信号在正常听觉范围
内。

Acoustilyzer 设定:

•	 IN:MIC (INT), 使用 Acoustilyzer AL1内置
的麦克风。

•	 IN:XLR/RCA,使用外部麦克风，例如 
MiniSPL。

选择极性测试频率范围:

•	 FULL/MID, 用于全频扬声器测试

•	 WOOFER, 用于低音扬声器测试

注意:
•	 请注意极性测试是复杂的信号相位简化的量测。驱动，扬声器与混合

声都会引起音频信号相位的偏移。 
•	 在音箱内的多个扬声器的极性可能不同。这是正常的。
•	 极性测试对于检查同类扬声器系统的布线是否正确非常有用。
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b. 缆线的极性测试

使用Minirator的极性测试信号提供给待测缆
线。Acoustilyzer 会分析缆线另一端信号的
极性。

Acoustilyzer 设定:
•	 IN: XLR/RCA, 
•	 Mode: Cable

以下的错误可以快速的被检查出:

•	 错误的极性, 可能是缆线内布线错误或瑕疵造成。

•	 缆线错误,不平衡的信号，显示于平衡指示器，可以帮助用户找出各种
缆线问题，例如:

“2UBAL–”  表示XLR缆线的音频信号只有接脚2有信号 → 接脚3没信
号。

“-UBAL3”    表示XLR缆线的音频信号只有接脚3有信号 → 接脚2没信
号。

若平衡指示器偏离中央，由于其它缆线的问题，详细的说明可参考NTi 
Audio应用手册 “Signal Balance“ (可以在NTi Audio网站下载)。

电平的量测在应用中很有用，例如测试多芯的电缆 (可参考 NTi Audio 网
站的应用手册)。
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延迟时间

从扬声器到扬声器的声学传播延迟时间设定，例如教堂或听众席,是需要使
听众注意声音来自演讲者而非来自旁边或后面的扬声器。

Acoustilyzer 量测扬声器信号 (使用内置的麦克风) 与电气线参考信号 (连接 
RCA 或 XLR 输入端)的延迟时间。延迟时间的测试信号为啁啾(chirp), 在AL1 
测试光盘内有，可以加以使用。

转换延迟时间
单位为 米/呎

延迟时间
记忆

自动计算延迟时间
存储- 实际

    开始同步        同步时间条
     100% = 100 秒

实际测量的延
迟时间相对于
电气参考信号

  状态指示

同步: 自动同步容许在没有任何电气参考信号下进行100秒延迟时间测量与
显示下一个同步所剩余时间。

手动同步: 
选择SYNC对手动同步进行初始化。



48 49

如何量测
注意:    请停止光碟的防震功能因为那可能造

成测量结果不精确!

测量准备
•	 开启声学延迟时间测量信号，可用AL1

测试光碟。
 
•	 连接到电气信号，例如从光碟播放器到

AL1 RCA 或 XLR 输入。

•	 等待直到 Acoustilyzer 与收到的延迟时
间测试信号同步以及同步时间条到100%
。

延迟时间测量经由同步的电气输入信号与
Acoustilyzer 内置麦克风之间计算出。

量测参考扬声器
•	 选择一个扬声器当作参考扬声器，叫扬

声器A，例如在延迟时间最前面的一个扬
声器。

•	 将你自己位置处在声场靠近另一个待测
扬声器例如叫它扬声器 B，测量延迟时
间与参考扬声器 A 比较。

注意:	 不要将AL1放置太靠近反射面，例如
墙或地面。反射可能造成量测不精
确。
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改变 
[m][°C] ↔ [feet][°F]

•	 启动在扬声器A的测试信号，所有其他的
扬声器应该关掉。

•	 声学信号的延迟时间参考电气输入信号
以毫秒显示. 测量的距离结果以米/呎显
示以便于验证测试结果. 读值基于音速于
温度0°C / 32°F为330 米/秒。

•	 设置实际环境温度，显示正确的距离。

存储参考结果
•	 选择STORE 以记忆测试结果作为延迟时

间测量参考记录。
•	 存储的参考延迟时间显示在延迟时间记

忆区内。

测量到扬声器的传播时间
•	 启动在扬声器 B 的测试信号，所有其他

扬声器都应该关掉。
•	 扬声器 B 的声学延迟时间相对于电气输

入信号以大的显示结果显示。

自动计算时间差
•	 自动计算时间差和显示在上方小的 STO-

ACT (存储 - 实际) 栏。 
自动计算时间差简化了延迟线的安排与
验证例如用于教堂或演说会场。
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电气量测 - 有效值/总谐波失真

Acoustilyzer 支持一些电气量测的功能，例如:
•	 电平有效值，反映输入信号的绝对电平。
•	 总谐波失真加噪声(THD+N)，除了检验正弦波的线性信号纯度 - 例如测

量谐波失真的含量 - 此模式特别适合得知信号中有没有其他不希望有的
干扰成分如交流哼声的存在。

总谐波失真加
噪声

信号频率
信号平衡指
示器

电平有效值与
单位

 

电平有效值: 可选择单位 dBu, dBV, dBSPL与 V 。

总谐波失真加噪声: 失真量测, 以 dB 或 % 表示, 频宽 10 Hz - 20 kHz。
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信号平衡 显示接脚 2 与接脚 3 的误差，以 % 表示。箭头的位置表示:

•	 箭头在中央表示输入信号是平衡的。

•	 箭头不在中央表示平衡有问题。如果箭头往左靠近数字2，表示接脚
2的信号电平高于接脚3。

•	 箭头在最左边或最右边表示信号平衡误差33%或更高。误差33%等
于 信号声压相差 6 dB。

•	 2UBAL-, 表示平衡的XLR缆线音频信号只有接脚 2 有信号 → 接脚 3无
信号。

•	 -UBAL3, 表示平衡的XLR缆线音频信号只有接脚 3 有信号 → 接脚 2无
信号。

注意:
•	 -20dB 适配器可用于当平衡输入电平高于+20 dBu时 (详细信息请参考

附件)。
•	 总谐波失真结果的量测频宽为10 Hz - 20 kHz。
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语言清晰度 STI-PA (选件)

语言清晰度量测 STI-PA 是 Acoustilyzer AL1 的选购套件。可以向您当地的
代理商询问购买细节。

STI-PA 选项可以在 15 秒内量测出可靠的语言清晰度。除了单一值或测试结
果，也提供各频段的调制函数与声压。STI-PA 遵从最新的 2003 IEC 60268-
16 标准，一个 TNO 验证演算法 (荷兰的 STI-PA 研究学院)。
关于语言清晰度基础与历史发展的更多信息可参考本手册附录部分。

a. STI-PA 量测屏幕

目前声压级

量测完成度 (0..15 秒)

模拟STI-PA 条状图 

STI-PA 测
试结果

开始量测

量测状态标示

STI-PA 测试结果: 单一值语言传递指数 STI (语言传递指数) 或 CIS (共通理解
性尺度), CIS 的计算是 CIS = 1 + log STI。

声压级: 显示目前 SPL 值，以 dBAS 表示,包含 A-计权与Slow 时间计权。 
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b. 如何量测

•	 选择 STI-PA 功能。 
•	 从Acoustilyzer 监看目前环境的声压级。

前置条件:
•	 为避免量测失败，STI-PA 测试信号声压

至少要 60 dBSPL。
•	 在紧急状况下应该进行STI-PA 测量  (同

样的声压级且所有的成分被激活)。 
•	 在15秒的测量期间不可以有脉冲噪声出

现。

注意:	 即使是中间噪声也会影响到STI-PA测
量结果。

信号来源:
NTi Audio TalkBox 能模拟人的说话，使系统
能完整的包含麦克风部分 (方向性,房间的特
征, ...)。将 NTi Audio TalkBox 置于典型的演
说者的位置。

一个光盘播放 NTi Audio 光碟 “STI-PA V1.1”
能用来作为电气注入信号而不需要麦克风部
分。
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•	 起动 STI-PA 测试信号。
•	 根据典型紧急情况要求设置 PA 系统的声

学声压级，例如 85 dBAS。

•	 在 AL1 菜单按 START 初始化测量。在测
量中不允许讲话或其他噪声靠近测量麦
克风。

一次 STI-PA 测量需要 15 秒。在上方的测量
进展条的空白部份可观察已经进行的时间。

测试结果的倾向显示在STI-PA以下的条状
图, 标记 BAD, PR (poor), FR (fair), GD (good) 
与 EXLT (excellent)。

在 15 秒测试时间后测量状态显示FINISHED 
且显示最终的 STI-PA 测试结果。

在语言理解性品质测试条状图结果显示如下

•	 BAD					     0.00 - 0.30 STI
•	 PR (poor)			  0.30 - 0.45 STI
•	 FR (fair)				    0.45 - 0.60 STI	
•	 GD (good)			   0.60 - 0.75 STI
•	 EXLT (excellent)	0.75 - 1.00 STI
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详细的调变指标测试结果与个别的频带电平
结果显示在第二个STI-PA 测量屏幕。

c. 读出详细的测量结果

STI-PA 倍频程
频带 

个别倍频程频带
LEQ电平 

STI-PA 调变指数2STI-PA 调变指数1

检测错误 

STI-PA 调变指数 1 & 2: 
对于高的语言理解度完整地传递语音调变信号是必须的。因此 STI-PA 是基
于测量 MTF (Modulation Transfer Function)。这个功能量化语音调变保存在
个别倍频程频带的程度. STI-PA 以分析所有7个频带决定 MTF，靠每个频带
一两个频率调变，得到调变指数1 与指数 2。 



56 57

d. STI-PA 后处理

在现实噪声环境下常常是不能测量语音可理解性的，例如，在火车站这些
测量有可能不能在有高的背景噪声的尖峰时间里进行。实际上 STI-PA 测量
多在晚上人比较少的时候进行。 

因为这特殊的应用 STI-PA 在较安静的环境下测量结果能被以最坏的噪声频
谱作后处理，预测在这些最坏的噪声可能的语音可理解性。

微软 Excel 程序 “STI-PA_PostProcessing.xlt” 结合 “noiseless” 记录的 STI-
PA 在最坏的噪声频谱结果及预测语音可理解性 STI 值。STI-PA 与 RTA 结
果 (1/3 与 1/1 倍频程)记录与存储于  Acoustilyzer 可以导入 (使用 MiniLINK 
软件将这些测量结果从 AL1 传到计算机)。

“STI-PA_PostProcessing.xlt” 可以从下列方式得到
•	 在网页 “http://www.nt-instruments.com/acoustilyzer”下载
•	 “MiniLINK - 计算机软件”光盘

注意: 在开启后处理工作表示所有的宏都应被激活。 
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e. STI-PA 错误侦测

Acoustilyzer STI-PA 测量功能具备侦测功能,能帮助你确认无效的测量,  侦测
功能检测下述参数:

•	 无效的调变指标 (MF1 或 MF2 > 1.3) 
•	 在测量进行中不正常的规律

以上参数依赖环境的瞬间噪声。瞬间的环境噪声影响任何 STI-PA 测量，同
时造成测量值的不精确。

如果侦错功能发现任何问题 STI-PA 测试结
果显示会被闪烁的 “?.??” 问号所中断。 

这个错误侦测功能指示可能由于以下所造成
•	 失去测试信号电平
•	 发生瞬间脉冲噪声事件

详细的测试结果屏幕
倍频频段被检测到不规则，以问号(?)标记。

建议
如果错误侦测发现任何的错误 NTi Audio 建
议重复进行测量与之前的 STI 测试结果比
较。
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f. STI-PA 测量提示

1.	 任何背景噪声在测试进行中必须足够的静态，例如粉噪声满足此要求。

2.	 在测试前验证环境情况，在没有任何测试信号下做完整的 STI-PA 测量。
测试结果应该 < 0.20 STI。

3.	 在测量中瞬间脉冲背景噪声像是语音，会造成严重的测量错误。STI-PA 
测量结果通常过高。

4.	 如果不能防止这些瞬间脉冲噪声，测量的结果可能偏差，例如晚上，然
后以白天的平均背景噪声校正，使用外部的后处理程序。

5.	 任何作为产生 STI-PA 测试信号的光盘播放器对时间的偏移必须精确到 
(+/- 200 ppm) 以确保可靠的 STI-PA 测量结果。不可用防震功能，NTi 
Audio 建议只使用专业光盘播放器。

	 你可以9kHz测试信号对你的光盘播放器对于时间的偏移: 
•	 使用 NTi Audio Wavefilegenerator (可由网址 “www.nt-instruments.

com/downloads”下载) 产生9000 Hz 正弦波测试信号并复制到光
盘。

•	 插入此光盘到光盘播放器并播放 9 kHz 测试信号。
•	 将 Acoustilyzer 连接到音频输出直接在 RMS/THD 模式测量信号频

率，显示的频率应该在 8998 到 9002 Hz 之间(最后一位数在9 kHz等
于111 ppm)

6.	 其他测试系统制造商的 STI-PA 测试信号也许听来相似但不兼容。只有 
NTi Audio STI-PA 测试信号光盘 V1.1 或更高版本才能与 Acoustilyzer AL1
一起使用。

7.	 警报系统的 STI-PA 测量应该在紧急的情况下测量 (同样的声压级与所有
的成分都激活)。

8.	 在不同环境情况的场所，例如只有少数人或人潮拥挤的的公共场所，必
须测量到最坏的情况的 STI-PA 测量结果。

9.	 选择具有代表性的位置，例如将麦克风定位在离地面距离 1 - 1.2 米的听
众席或是离地面距离 1.5 - 1.8 米的站位 (典型的测量位置通常不是直接在
扬声器面前)。
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10.	测量人员应该在声场以外，以避免影响测量结果。基于这个考量测量
可以将麦克风安装在麦克风支架上以电缆连接(使用麦克风延长电缆)到 
AL1。

11.	低 STI-PA 读值可能是由于
•	 过度的残响，回声或反射
•	 不当的演说者方向或演说覆盖面
•	 功率设置不适当 (例如低信噪比)

更多信息请参考 NTi Audio 网站或附录。
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校正

为了要确保正确的测量结果，接到AL1的麦克风的灵敏度也必须经过校正。
麦克风的灵敏度设置在 NTi Audio MiniSPL 测量麦克风出厂调整的默认值 
20mV/Pa。MiniSPL 是  Acoustilyzer AL1的专用麦克风。由两者组建成专业 
class 2 声学分析仪。 

除了 MiniSPL 麦克风之外也可选用 NTi Audio M2010 class 1 频率响应麦克
风作为高精度 class 1 声学测量。

麦克风灵敏度
麦克风平衡指示器, 
验证麦克风输入信号的平衡

出厂默认的
设定

使用外部的麦克风校正

有三个校正模式:

DEFAULT
所有 MiniSPL 麦克风出厂校正的灵敏度为 
20.0 mV/Pa。要重置预设请:

•	 选择 DEFAULT
•	 按回车键
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CALIBRATE 
灵敏度可以用外部的校正器调整。
•	 选择dBSPL值的区块(预设为114dBSPL),

按回车，依校正器调整声压级。使用上/
下键每按一下调整1.0dBSPL，左/右键每
按一下调整0.1dBSPL。支持电平范围为
80- 140dBSPL。

•	 按回车按确认。
•	 从校正器产生专有的参考信号到麦克风

上。 
•	 按回车开始进行校正，校正器的参考信

号不中断。
•	 出现 WORKING ... 窗口，完成后屏幕会

出现 CALIBRATION FINISHED!  
•	 新的灵敏度显示 mV/Pa。
•	 进入SPL/RTA 量测模式，再使用参考信

号检查麦克风校正是否正确。

校正错误会显示在屏幕上，可以引起错误的
原因有 
•	 太低或太高的输入电平。
•	 灵敏度超出范围 2 - 80 mV/Pa。

手动设定灵敏度

•	 选择灵敏度区块如左图。 
•	 按回车后调整灵敏度，使用上/下键每

按一下调整1.0dBSPL，左/右键每按一
下调整0.1dBSPL。支持电平范围为80- 
140dBSPL。

•	 按回车确认。
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5. 	 MiniLINK 计算机软件
MiniLINK 计算机软件可以将上保存的数据转到计算机上。另外也支持从计
算机上在线记绿量测数据。

安装

a.	 打开装有微软 Windows 操作系统的计算机 (MiniLINK 支持 Windows 98 
SE, 2000, ME , XP与VISTA)

b.	 将附件中的 MiniLINK CD 光盘插入光驱中。 

c.	 MiniLINK 软件安装程序会自动运行。依屏幕上的步骤安装。

	 如果光盘自动播放未启用，请依下面步骤进行安装:

•	 点击屏幕左下方“开始 → 运行“ 。

•	 输入 “d:\setup“ ( “d“ 为光驱所在位置) 

•	 点击 “确认“。

	 完成安装后, MiniLINK 光盘先不要从光驱中退出

     注意:		  如果MiniLINK 计算机软件之前有在计算机中安装过，旧的版本
会自动被卸载。卸载后，您必须再运行安装程序安装软件。

d.	 使用附件的 USB 缆线连接仪器与计算机。Windows 会自动找到新硬
件，开始安装硬件驱动。

	 依屏幕指示安装驱动。当安装过程中需要USB驱动的来源时请选择
MiniLINK光盘所在位置。

	 安装过程中出现微软的警告信息，请按继续安装。



64 65

运行 MiniLINK 计算机软件

安装完驱动后，MiniLINK 软件就可以运行了。

•	 要运行软件，可以从 “开始 → 程序 → MiniLINK” 中启动。 

•	 仪器在接上计算机会自动启动，屏幕视窗显示如下图:

仪器电源由 USB 接口供应，所以会自动启动仪器。在与电脑连接时操作期
间请勿移除仪器上的电池。
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免费注册您的仪器

Acoustilyzer 包含附加功能，在 NTi Audio 网站注册后激活。

可用的附加功能:

仪器 功能 显示
AL1 客户化起启屏幕

在线注册:
运行 MiniLINK 软件后，若连接的仪器尚未注册会建议注册仪器。可以依照
指示进行注册或选择 MiniLINK 软件菜单列上的“Help → Register“。

离线注册:
从“http://registration.nti-audio.com/Registration.php”的网页上注册。请
输入您的详细信息与产品序列号。产品序列号在开启仪器时按住开关键不
放，可以保持显示。产品序列号起始三位是英文字(例如:ANK675A0A2)。

在成功注册几分钟后，您将会收到一封有注册码的e-mail，请从菜单列的 
“Help → Register“ 中输入注册码。仪器必须与计算机连接。
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导出保存的测试结果

仪器记忆体中的数据会自动转到计算机，在 MiniLINK 软件的记体体视窗中
以缩图显示。

注意:	 当仪器内没有任何保存的测试结果，在 MiniLINK 记忆体视窗中则没
有任何数据。此外，用鼠标点击 “AL1 Memory“ 标签可更新记忆体
视窗中的数据。

计算机 MiniLINK 上仪器图的显示内容是与所连接仪器上的显示屏内容相
同。软件视窗上方显示所连接仪器的序列号与韧件版本。

与仪器同步显示MiniLINK 软件的
版本

所连接仪器的韧件
版本

所连接仪器的序
列号
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观看测试结果

所有保存的截图会显示在 MiniLINK 的 “AL1 Memory“ 标签。

 

保存的截图包含数值的结果 保存没有截图的数据

键头表示截图中也有保存数值的测
试结果

截图中的详细数据
双击截图会放大截图。在这里，上方菜单列
有打印，保存，复制截图或数值的测试结
果。

所有详细的数据会显示在下方，如左图。
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复制测试结果与截图

所显示的截图可以复制到别的文件。

•	 选择菜单列 “Edit → Copy Bitmap” 可以选
择复制截图，或选择菜单列 “Edit → Copy 
Text” 复制数值数据。

•	 使用 “Ctrl + V” 键将刚才复制的数据粘贴
到您的目标文档上，例如 Excel, ...

也可以导入保存的“*.txt”文档，例如使用
Excel 的导入功能导入到 Microsoft Excel 工
作表中。
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范例: 显示 SPL/RTA 测试结果

SPL/RTA 声压级量测有下列的测试数据结果:

•	 测试配置参数

•	 时间, 记录相关时间。

•	 所有声压相关的参数，如下图。 
(详细信息请参考 “SPL/RTA - 记忆体功能” )。
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保存测试结果与截图到计算机上

显示的截图会以位图(*.bmp)方式保存到计算机的硬盘上。所有数值的数据
会以文档(*.txt)方式保存。档名前六位数为仪器序列号前六位数。 

例如仪器Acoustilyzer S/N ANK675上截图“A011_RT60”记录会保存为 

•	 “ANK675_A011_RT60.bmp” 

•	 “ANK675_A011_RT60.txt”

可以在同一台计算机上保存不同仪器的测试结果。依下列步骤保存到计算
机中(预设路径为C:\Program Files\MiniLINK\Data):

•	 在软件上的记忆体窗口中选择要被保存的截图。

•	 按 SAVE 标签或从菜单列上选择“File → SAVE“。

•	 会出现一个视窗如下图。选择配置后按 SAVE 。
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当数据保存到计算机的同时，仪器上同笔的数据可以自动被删除。只需要
勾选上图中 “Delete files in instrument memory after save” 下的选项。

删除仪器记忆体中的测试结果

删除仪器记忆体中的测试结果有以下方式:

•	 直接从仪器中操作删除数据。

•	 选择记忆体视窗中的截图，按计算机键盘上的 DEL 键或 MiniLINK 菜
单上的 delete。

•	 保存数据到计算机上时勾选保存后自动删除仪器上的数据“Delete 
files  after save”。

测试结果在线记录在计算机中

MiniLINK 可以在用户定义的时间间隔连续在线记绿仪器的测试结果。在记
录过程，测试数据会保存在暂存在软件中。结果记录后按可以保存在硬盘
中，档名范例为 “ANK675_PcLog_Level SPL”。

在线记录的功能很适合长时间的监看或除错，例如维修或广播应用。
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直接复制目前截图(到剪
贴本)

要在线记绿测试结果，请依下列步骤操作:

•	 在仪器上选择需要量测的功能。

•	 选择软件菜单上的“Logging“标签。

•	 选择需要记录的时间间隔。

•	 按“START”开始记录。

•	 要结束记录按“STOP”。

•	 按“SAVE”保存记录。

可以用鼠栋按软件上复制图标直接复制目前显示的截图。要将复制的截图
粘贴到档案中可按 “CTRL + V”。
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用计算机控制仪器

MiniLINK 从计算机上支持遥控仪器。只要用鼠标点击软件显示的仪器图上
各个键，或使用下图列出的键盘热键。

 

        

方向键与回车

背光: Ctrl + L退出

开/关: Ctrl + P

	

按键盘上“Shift ←” 或 “Shift →” 组合键，或上图所标示的仪器左右两边，可
以切换目前量测功能的结果显示方式(图或数值)。

 

点击此区可以切换屏
幕结果显示方式 
(例如 SPL ↔ RTA)
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MiniLINK 工具

MiniLINK 计算机软件包含许多有用的工具:

•	 LCD 全屏幕显示

•	 更新韧件

•	 转换仪器功能的韧件

•	 起始屏幕
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LCD 全屏幕显示

仪器目前的显示在计算机上可以全屏显示。

进入全屏显示模式:
• 选择 MiniLINK 菜单列上 “Tools → FullScreen“ 或点击  图标。

离开全屏显示模式:

	 •	按键盘 “Q” 键或用鼠标点击一下屏幕。

进入全屏显示
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更新韧件

NTi Audio 网站“www.nt-instruments.com”提供免费的仪器韧件更新。 

依下列步骤查看是否有可用的更新:
•	 将计算机连上网络，运行计算机软件。
•	 用USB缆线连接仪器与计算机。C
•	 选择MiniLINK菜单列 “Help → Look for Updates“。
•	 依照指示下载韧件

您也可以从网站上“http://registration.nti-audio.com/VersionCheck.php”网
页检查是否有新韧件与软件发布。

•	 选择MiniLINK菜单列上 “Tools → Update Firmware“ 。

在显示的视窗中选择较新的韧件版本:

对于
MinilyzerML1:
ML1dA_V3.xx.bin

对于 Acoustilyzer:
AL1dA_A1.xx.bin

适用于所连接仪器的
韧件 

在选择了韧件后，仪器的韧件会自动更新。
 

注意:	 若在更新韧件时发生任何问题，例如电源中断等等，可在之后重新
再更新一次。
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转换仪器功能韧件

Acoustilyzer AL1 与 Minilyzer 是使用相同的硬件，安装不同的韧件。功能
转换的韧件可以使 ML1 转换成 AL1 或将 AL1 转换成 ML1。

•	 选择MiniLINK菜单列上 “Tools → Crossgrade Firmware“。

选择韧件版本如下图:

对于Minilyzer L1:
AL1dA_A1.xx.bin

对于Acoustilyzer:
ML1dA_V3.xx.bin

适用于所连接仪器的
韧件 

确认后，转换韧件会在几秒钟内自动安装。仪器会显示UPDATING 
FIRMWARE。

注意:	 在转换后，仪器内记忆体保存的数据会被删除。
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客户化起始屏幕

MiniLINK 计算机软件支持起始屏幕客户化。在每次开启仪器，客户定义的
起始画面会取代出厂预设的画面。

•	 运行 MiniLINK 计算机软件。

•	 使用 USB 缆线连接仪器与计算机。

•	 选择 MiniLINK 菜单列上的 “Tools → StartupScreen“。

屏幕上会显示一个视窗，如下图:

“Set Startup Screen” 视窗会显示出厂预设的起始画面。中间白色区域(100 
x 32 像素) 可以让用户自定义。上面和下面的灰色区域为固定不可更改。
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如何定义新的起启画面:

•	 使用之前定义过的图片。MiniLINK 会自动转成黑白的100x32像素图片，
起启画面可使用*.pcx;*.bmp;*.dic;*.rle;*.ico;*.wmf 格式的图片。

•	 您也可以使用绘画软件创建一个新的起启画面，例如 Windowns 系统附
件中的画图，画布尺寸设为 100x32 像素，编辑内容，保存为“*.bmp”
格式。

•	 按 “Load Image” 选择起启画面的档案。 

•	 起启画面预览会显示在计算机显示器上。

•	 按 “Send to Device” 将档案传到仪器上。

•	 仪器会自动重启，您可以看到新的起启屏幕。

起始画面范例:
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激活选项

激活选项是用于

•	 激活功能转换韧件，使ML1与AL1的功能可以转换。

•	 激活仪器的 STI-PA 语言清晰度量测功能。

要激活上述的功能请:

•	 选择 MiniLINK 菜单列上的 “Help → Activate Options“ 。

•	 会显示如下图的视窗

依照指示输入激活码，附件中的产品套件附有认证码。
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6. 	 疑难排除

数值的数据 “*.txt” 文档导入到 Excel

问题:
数值当被导入到 Microsoft Excel 只被辨识为文本，以致于你无法创建表格
于使用这些数据来进一步计算。

解决方法:
MiniLINK 数据文档使用 “.” 如小数点分隔符。因此当导入数据到 Microsoft 
Excel 过程中请设置小数点分隔符 “.”。 
或者你可以使用复制 → 粘贴功能，选择菜单 “Edit → Copy Text” 将数据粘贴
到一个新建的 Microsoft Excel 工作表中。

出厂预设状态

要重置仪器到出厂时的设定请依下列步骤操作:

•	 关闭仪器电源

•	 同时按下退出键与开始键几秒
•	 显示起启画面，下方会出现 “LOADING DEFAULT SETUP”

现在仪器已重置到出厂时状态。
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7.	 附件

MiniSPL
MiniSPL麦克风是声学量测上很好的附件。
与 Acoustilyzer AL1 连接使用可以做很广泛
的声压量测。 

MiniSPL 英寸全指向型的量测麦克风，内置
阻抗转换，前置放大器。由电池供电，平衡
的XLR输出。依据IEC 61672标准，MiniSPL 
是级别2的麦克风，出厂的灵敏度为 20 mV/
Pa。

STI-PA 量测选件
STI-PA 分析选项可以在15秒内提供可靠的语
言传播索引，依据IEC最新的标准。另外单
一值 STI 或 CIS 测试结果，提供调制索引与
独立频段等级结果。

NTi Audio TalkBox
TalkBox是完整的评价紧急救生安全广播系
统语音理解度所缺少的一链接环，由发话者
麦克风到收听者的耳朵。NTi Audio TalkBox 
依据 IEC 60268-16 标准模拟人类发话近似
语音的声学信号，结合一个符合TNO公证的
语音理解度标准信号和信号电平。
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ML1 - AL1 功能转换套件
ML1 - AL1 功能转换套件可以载入 ML1 的韧
件到您仪器中，提供以下的测试功能
•	 vu-PPM
•	 平衡
•	 2阶到5阶谐波总

谐波失真
•	 示波器

•	 扫频
•	 时间扫瞄
•	 感应环路模式 

适配器 -20dB
-20dB 适配器可以用在平衡输入电平高于
时。-20dB 衰减适配器延伸了 Minilyzer/
Acoustilyzer 电气量测范围到 +40 dBu。
适配器配有pin1-保险丝以确保与USB接口 
MiniLINK一并使用时的安全。

软包
软包可以保护您的仪器，避免震动，灰尘，
水。腰带扣可以将仪器系在腰间，让您方便
工作。

便携系统工具箱
可以放Minirator MR1,Minilyzer ML1或 
Acoustilyzer AL1与MiniSPL 。还有额外的空
间放置电缆，连接器与其它的附件。对于携
带外出非常方便。
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8.	 技术规格
量测

•	 声压级
•	 实时频谱分析
•	 Zoom FFT
•	 混响时间
•	 延迟时间
•	 电平有效值
•	 总谐波失真+噪声
•	 频率
•	 极性测试
•	 语言清晰度 STI-PA (选件)

声压级
	 •	 声压级, 噪声等效声级, C-计权峰值声压级, 时段内最大/最小声		

压级，依据IEC 61672标准
	 •	 单一与重复量测的计时器

•	 动态可调范围 (使用 MiniSPL): 30 - 130 dBSPLA
•	 滤波器: 平坦, A, C, X-曲线-1, RLB (广播响度)
•	 记录 SPL/RTA 测试结果到 AL1 记忆体
•	 全频段实时分析值

实时频谱分析 
	 •	 1/3 或全倍频程分辨率，级别 0 滤波器

•	 显示每频段的声压级，噪声等效声级与时段内最大-最小声压级

Zoom FFT
	 •	 实时 Zoom FFT ，50% 重叠, 93 个频点

•	 频率范围: 10 Hz - 20 kHz
•	 分辨率: 187.5 Hz 到 0.73 Hz

混响时间
	 •	 全倍频程分辨率, 63 Hz - 8 kHz, 基于T20结果, 依据ISO3382标准 
	 •	 自动平均每个频段的结果并保存

•	 来源信号: 闸控粉噪声 (光盘内有)

延迟时间
	 •	 使用内置的麦克风量测电气与声学信号间的传送延迟，分辨率 < 	

	 0.1ms, 最大时间: 1 s
•	 专用的测试信号: NTi Audio chirp (光盘内有)
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电气	
	 •	 电平有效值, 总谐波失真+噪声, 频率, 极性

STI-PA (选件)
	 •	 单一值 STI 与 CIS 测试结果。调制索引与独立频段的级别。错误		

指示
	 •	 依据 IEC 60268-16  2003 发布的标准 
		  (包含振幅计权)

•	 TNO 验证演算法

计算机接口
	 •	 MiniLINK USB 接口含缆线与计算机软件

频率
	 •	 范围	 10 Hz 到 20 kHz
	 •	 分辨率	 4 位数
	 •	 精度	 < ± 0.1 %

电平
	 •	 单位	 dBu, dBV, VRMS
	 •	 分辨率	 3 位数 (dB) 或 4 位数 (V)
	 •	 精度	 ± 0.5 % @ 1 kHz
	 •	 频宽	 20 Hz 到 20 kHz
	 •	 平坦度	 ± 0.1 dB

THD+N (总谐波失真 + 噪声)
	 •	 量测频宽

		  10 Hz 到 20 kHz
	 •	 分辨率	 3 位数 (dB) 或 4 位数 (%)
	 •	 残馀 THD+N

		  平衡  < -85 dB @ -10 dBu 到 +20 dBu
			   不平衡  < -74 dB @ 0 dBu 到 +14 dBu

极性测试 (MR1 的测试信号)
	 用内置的麦克风或 XLR RCA 连接口检查正/负极。中音扬声器，低

音扬声器，缆线。 输入信号信噪比降至 10 dB 。

滤波器
	 •	 平坦	 •    C-计权	 •    高通 400 Hz

•	 A-计权	 •    X-曲线-1	 •    高通 19 kHz
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输入连接口
•	 XLR 平衡, RCA 不平衡

输入阻抗
•	 40 kOhm 平衡, 20 kOhm 不平衡

输入有效电平 ( 量测上限 )   
	 •	 平衡	 +20 dBu (7.75 VRMS)
	 •	 不平衡	 +14 dBu (3.8 VRMS)

•	 对于输入电平 > 20 dBu (平衡) 可使用附件 -20 dB 适配器
		

最大直流电源输入
•	 ± 50 VDC

残馀杂讯
•	 < 12 μV, XLR-输入短路

内置麦克风 (只用于极性与延迟量测)
	 •	 全指向

监听输出
•	 3.5 mm (1/8“)插口, 适用任何一般耳机

显示器	 图形液晶 64 x 100 像素, 带背光

电池
•	 3x AA 电池 (碱性)
•	 典型电池寿命 > 16 小时

尺寸 (长x 宽 x 高)
	 •	 163 x 86 x 42 mm (6.4“ x 3.38“ x 1.63“)

重量
•	 300 克 (10.5 盎司) 包含电池

温度
•	 0° 到 +45° C (32° 到 113° F)

湿度
< 90 % 
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9.	 附录: STI-PA 概述

应用:
在紧急装况下，建筑物如机场，火车站，商业大楼，或音乐厅等公共广播
系统必须清楚地告知里面的人员处于危急之中和有关的逃生信息与逃生方
向，然而如果这种广播信息因为劣质的广播系统而导致被误解，可能导致
悲剧的发生，因此，设计，安装，与验证声音加强系统的可理解度是必要
的，另外，一些其他相关应用例如法律与医学也可能需要语音理解度这方
面的鉴定。

标准:
IEC 60849 标准 (国际标准 - 参考列表) 要求确定在实际的环境中用于紧急电
声系统验证语言清晰度的最低水平，从而，语言清晰度从管理察看的不再
是主观的测量，而是能被在 IEC 60268-16 标准采用的多点或少点复杂度的
方法所验证。

国际标准:
• IEC 60849 紧急用途声音系统 (同 VDE 0828 第 1 篇 与 DIN-EN, BS-EN, 
SN-EN, OEVE-EN, …) 
• NFPA 72 国家火警警报法规 2002 (2002 版本, section 7.4.1.4节) 
• BS 5839-8 建筑物火灾侦测与警报系统，语音警报系统的设计，安装与维
修工作法规。 

主观的测试方法:
尽管频率响应，失真或响度都对语言清晰度而言是重要的，由来已久的测
量这些参数只是稍稍沾上语言清晰度一点关系，当一些增加的争议出现例
如扬声器的方向与环境因素列入考虑，问题变成发话者的发言信息对在各
不同位置的聆听者理解到什么程度。
 
一种途径是让一位受过训练的人对一些代表性的听众讲一些综合性的话。
个别的写下他们认为所了解的内容，统计分析这些记录结果以百分比表示
听众对信息理解的正确性。
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根据这个方法重要的过程为 PB-words, CVC 或 SRT (Speech Reception 
Threshold)。然而，采用这样测试是比较花成本的，而且有些甚至是不可能
的危险的地方。因此，这些方法主要用于在发展阶段验证技术原理。

科学方法:
回溯在1940年，贝尔实验室已经开启发展测量语言清晰度技术。现代，
高度发展的演算法则如 SII (Speech Intelligibility Index) 与不同形式的 STI 
(Speech Transmission Index) 可以测量语音理解度，这些技术处理许多对理
解度重要的参数如:

•	 语音电平

•	 背景噪声电平

•	 反射

•	 混响

•	 精神声学效应(屏蔽效应) 

测量技术使用合成测试信号不同于语音,但是与实际的语音信号有很多的共
同特性，平均的频率响应与低频调制是基于人类语音。由于男性与女性语
音声音发声的不同,一些测量技术采用男性与女性分别的测试信号:语言清晰
度以评估语音自发话者到收听者之间的变异，广泛的调查显示语音特性与
语言清晰度的关系变异，这些发现结合成了语言清晰度度表，能显示语言
清晰度，结果以单一数值0(不能理解的)与1(非常好的理解度)之间表示。

STI, RASTI 或 STI-PA

STI，RASTI 或 STI-PA 为已制定的测量语言清晰度方法。三种方法基本上采
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用相同的原理，藉着 RASTI 与 STI-PA 简化版的 STI。本文章解释这些方法
背后的原理。

语言模型:

首先,测量语言清晰度需要语音信号的雏型，例如,语音可能被描述成各种不
同的声音频率调制与加叠而成(例如振幅的变化)。

频谱:
典 型 的 对 男 性 语 音 在 一 定 周 期 中 的
的 频 率 分 析 的 结 果 特 性 显 示 如 图 1 。

图 1 : 男性说话平均倍频频
谱。

时间调变:
在每一个频带，信号电平的变动，例如它的
由于发话者的 “调制” ，图 2 显示语音信号
在250Hz频带的包络，包络的外形是由语音
内容所决定。
经由分析包络的频谱能够显示语音调制在个
别的频带范围从 0.2 到 12.5 Hz。 图 2 : 语音信号的包络 (250 

Hz 频带)

图 3: 语音信号包络的频谱
(250 Hz 频带)

Modulation Transfer Function (MTF)

对于高语音理解度完整地调制的传送的语音信号被保存是必须的，因
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此，三个核心的理解度测量方法, STI, RASTI 与 STI-PA 为基于测量 MTF 
(Modulation Transfer Function)。这个功能量化语音调制保存在各频带的程
度。

图3显示的包络分为 1/3 倍频程频率，因此结果在 14 个频率带在 0.63与
12.5 Hz之间，调制转移函数决定每个语音频带 (参考图 1) 调制保存的好到
什么程度。

基于 MTF 结果与更多的参数如声压级听力临界，频率响应或精神声学效应 
(遮蔽效应) 使得可靠的测量语言清晰度成为可能，相对的计算基于广泛且深
入的与主观方法评估与比较持续的优化，测量完整的 MTF – 如 STI 要求– 会
变得相当复杂，例如，必须执行 14 * 7 = 98 个各别测量，从而得到15分钟
内的总的结果，因此，发展出不同的方案以减少测试时间以及使得语言清
晰度测量得以在便携式仪表上实现。
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STI - 语言传播指数 (Speech Transmission Index)

STI 结果为基于完整的 98 套测量而得，由于经由这种途径需要相当长的测
量周期，实务上比较不常采用。不过，STI 所代表的是测量语言清晰度最详
细的方法，同时大多是用在其他方法在不利的测量环境条件下不能提供可
靠的测量结果时采用，
实务上，STI 结果能经由计算测量到的脉冲响应 (MLSA) 得到，例如用一
台基于计算机的系统，这种途径是更快速的，但它需要很丰富的经验与特
别是系统设置上的表现是线性的，例如，必须不存在任何非线性处理或条
件，包含压缩器与限制器等，那是非常罕见的处境。

RASTI - 室内声学语音传播指数(Room Acoustics Speech Transmission 
Index)

RASTI 取得只有完整的 MTF 的少数片段，这是先检视明显的表现极单纯的 
STI，因而，必须谨守一些限制以得到可靠的室内声学语言清晰度RASTI 。 
此外， RASTI 结果不考虑有效与实际的如频响，回音，和与频率相关的混
响时间等辅助参数。

对于一个 RASTI 测量。只有考虑两个同时发生的信号频带，例如。 500 Hz 
与 2 kHz 频带然后相对的被调制在 4 与 5 个频率。
RASTI 的实务上运用主要限制在两个人之间测得。然而, RASTI 一直以来都
是便携式仪表能采用的唯一的方法。
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STI-PA - 公共广播系统的语音传播指数 (Speech Transmission Index for 
Public Address Systems)

由于对安全上更多的注意，新技术方法与 RASTI 的缺陷触发了扬声器制造
商 Bose 与 TNO 研究院研发了新的测量公共广播语言清晰度的方法，经过
这些努力发展出STI-PA，这个指标可以用便携式仪表快速与精确的测试。

如同RASTI一样， STI-PA 实行很简单的步骤来计算出 MTF，但是 STI-PA 以
分析所有 7 个频带来决定 MTF，藉着每一个频带是以两个频率作调制。
假设没有严重的环境噪声脉冲出现与没有大量的非线性失真发生，STI-PA 
提供如 STI 一样精确的测量结果，但是如果在正常系统工作时间内出现环境
噪声脉冲，它通常可能会降低较有利的条件，例如区域内一些稍为不同的
条件效果或者是夜间，然后以两者测出的结果计算出一个总的测量结果。

NTi Audio STI-PA 测量表:

便携式 STI-PA 分析仪，例如， NTi Audio’s 声学分析仪，能够对每个位
置在15秒以内评量语言清晰度，因此适合用于大范围的测量与高的测量效
率。

更多信息请参阅网页 “http://www.nt-instruments.com/acoustilyzer.”.
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